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Legal Information
Copyright ©1994 - 2008 Sonic Solutions. All Rights reserved. Roxio Creator 2009, Roxio Easy 
Media Creator, Easy CD & DVD Creator, Easy CD & DVD Burning, WinOnCD, Retrieve, DLA, 
Music Disc Creator, MyDVD, Backup MyPC, Disc Copier, Label Creator, Sound Editor, Creator 
Classic, JUST!BURN, WOCBlock, CinePlayer, Roxio Updater, Media Manager, VideoWave, 
PhotoSuite, Roxio Easy DVD Copy, DVD Info Pro, Disc Image Loader, Easy Audio Capture, 
RecordNow!, DMX, CineMagic, Drag-to-Disc, Roxio Backup, Media Import, Disc & Device 
Utility, Express Labeler, Slideshow Assistant, Multi Photo Enhance, Panorama Assistant, Photo 
Email Assistant and all styles and templates are protected by copyright law and international 
treaties. Unauthorized reproduction or distribution of these programs, or any portion of them, 
may result in severe civil and criminal penalties, and will be prosecuted to the maximum extent 
possible under law. Use of these products is subject to the acceptance of the license agreement 
included in this product.

Sonic, Sonic Solutions, Roxio, the burning disc logo, Roxio Creator, Roxio Easy Media Creator, 
WinOnCD, PhotoSuite, VideoWave, the burning CD logo, Easy CD & DVD Creator, Easy CD & 
DVD Burning, Disc Copier, MyDVD, Creator Classic, JUST!BURN, Easy DVD Copy, BackUp 
MyPC, CinePlayer, RecordNow! and Drag-to-Disc are trademarks of Sonic Solutions, which may 
be registered in some jurisdictions. All other trademarks used are owned by their respective 
owners.

SOME OR ALL OF THE FOLLOWING APPLY TO THIS PRODUCT:

Portions of the software are provided by Apple Computer, Inc. Copyright © 2004 Apple 
Computer, Inc.

DivX and the DivX logo are registered trademarks of DivXNetworks, Inc. in the U.S. and other 
countries.

MPEG Layer-3 and mp3PRO audio coding technology licensed from Coding Technologies, 
Fraunhofer IIS and THOMSON.

http://www.iis.fhg.de/amm 
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Portions utilize Microsoft Windows Media Technologies. Copyright © 1999-2004 Microsoft 
Corporation. All Rights Reserved. Windows Media and the Windows logo are trademarks or 
registered trademarks of Microsoft Corporation in the United States and/or other countries. 

VST Plug-in Technology by Steinberg Copyright © 2004 Steinberg Media Technologies AG. 
Steinberg is a registered trademark of Steinberg Soft- und Hardware GmbH. 

Some digital content © 1994-2001 Hemera* Technologies Inc. All Rights Reserved. * Trademark 
of Hemera Technologies Inc.

Ogg Vorbis audio compression technology provided courtesy of the Xiph.Org Foundation.

libfishsound 

----------------------- 

Copyright (C) 2003, 2004 Commonwealth Scientific and Industrial Research Organisation 
(CSIRO) Australia 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

------------------------------------------------ 

libvorbis and libogg 

------------------------------------------------ 
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Copyright (c) 1994-2004 Xiph.org Foundation 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE REGENTS OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY O 
OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

------------------------------------------------------------- 

libflac and libflac++ 

----------------------------------------- 

Copyright (C) 2000,2001,2002,2003,2004 Josh Coalson 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE FOUNDATION OR 
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

-------------------------------------------------------- 

dsfOggDemux, dsfOggMux, dsfVorbisDecoder, dsfVorbisEncoder.dll, dsfNativeFLACSource, 
dsfFLACDecoder, dsfFLACEncoder, libOOOgg, libOOOggSeek 

------------------------------------ 

Copyright (C) 2003-2005 Zentaro Kavanagh 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS 
``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE ORGANISATION 
OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, 
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR 
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF 
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS 
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Audio effect engine licensed by Algorithmix. http://www.algorithmix.com

'Dolby' and the double-D symbol are trademarks of Dolby laboratories.

This product contains one or more programs protected under international and U.S. copyright 
laws as unpublished works. They are confidential and proprietary to Dolby Laboratories. Their 
reproduction or disclosure, in whole or in part, or the production of derivative works therefrom 
without the express permission of Dolby Laboratories is prohibited. Copyright 1992-1997 by 
Dolby Laboratories, Inc. All rights reserved.

Manufactured under license from Dolby Laboratories.

The TWAIN Toolkit is distributed as is. The developer and distributors of the TWAIN Toolkit 
expressly disclaim all implied, express or statutory warranties including, without limitation, the 
implied warranties of merchantability, non-infringement of third party rights and fitness for a 
particular purpose. Neither the developers nor the distributors will be liable for damages, 
whether direct, indirect, special, incidental, or consequential, as a result of the reproduction, 
modification, distribution or other use of the TWAIN Toolkit.

Music recognition technology and related data are provided by Gracenote®. Gracenote is the 
industry standard in music recognition technology and related content delivery. For more 
information visit www.gracenote.com.

CD and music-related data from Gracenote, Inc., copyright © 2006 Gracenote. Gracenote 
Software, copyright © 2006 Gracenote. This product and service may practice one or more of the 
following U.S. Patents: #5,987,525; #6,061,680; #6,154,773, #6,161,132, #6,230,192, #6,230,207, 
#6,240,459, #6,330,593, and other patents issued or pending.  Some services supplied under 
license from Open Globe, Inc. for U.S. Patent: #6,304,523.

Gracenote  the Gracenotelogo, the Gracenote logotype, and CDDB are  registered trademarks of 
Gracenote. MusicID  and the "Powered by Gracenote" logo are trademarks of Gracenote.
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For more information on using the Gracenote Service, visit: www.gracenote.com/corporate

Portions Copyright 1997, Chris Losinger 

Portions of this product were created using LEADTOOLS © 1991-2001, LEAD Technologies, Inc. 
ALL RIGHTS RESERVED.

Product includes the 3ivx Filter Suite. Copyright © 3ivx Technologies Pty. Ltd., 1999-2003, All 
rights reserved. 3ivx is an international trademark.

Some digital content provided by Digital Vision.

Certain templates and images: © 2004 ArtBuilders.

Some audio content provided by Darklab Sound.

Some audio content is provided by Todor Kobakov from spineproductions.net.

Some content courtesy of Artbeats. www.artbeats.com

Some digital image content © 2006 Jupiterimages Corporation. All Rights Reserved.

Some audio content © 2006 Ian Nieman Music. All rights reserved.

Portions Copyright 1997-1998 Intel Corporation. 
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This product uses the LAME MP3 Encoder library (the “Library”). The Library is licensed under 
the GNU Library General Public License, Version 2, 1991. For a copy of the complete 
corresponding machine-readable source code for the Library, send your request to Sonic 
Solutions, 101 Rowland, Suite 110, Novato, CA 94945 Attn: Legal Department. Processing, 
shipping, and handling charges will apply.

THIS PRODUCT IS LICENSED UNDER THE MPEG-4 VISUAL PATENT PORTFOLIO 
LICENSE FOR THE PERSONAL AND NON-COMMERCIAL USE OF A CONSUMER FOR (i) 
ENCODING VIDEO IN COMPLIANCE WITH THE MPEG-4 VISUAL STANDARD (“MPEG-4 
VIDEO”) AND/OR (ii) DECODING MPEG-4 VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL AND NONCOMMERCIAL ACTIVITY AND/OR 
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED BY MPEG LA TO PROVIDE 
MPEG-4 VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY OTHER 
USE. ADDITIONAL INFORMATION INCLUDING THAT RELATING TO PROMOTIONAL, 
INTERNAL AND COMMERCIAL USES AND LICENSING MAY BE OBTAINED FROM MPEG 
LA, LLC. SEE HTTP://WWW.MPEGLA.COM.

PSP is a registered trademark of Sony Computer Entertainment, and Memory Stick is a 
trademark of Sony Corporation.

The Bluetooth® word mark and logos are owned by the Bluetooth SIG, Inc., and any use of such 
marks by Sonic Solutions is under license. Other trademarks and trade names are those of their 
respective owners.

TiVo and the TiVo logo are registered trademarks of TiVo Inc. or its subsidiaries.

This product is protected by certain intellectual property rights of Microsoft Corporation. Use or 
distribution of such technology outside of this product is prohibited without a license from 
Microsoft or an authorized Microsoft subsidiary.

Windows Pre-Installation Environment. Disaster recovery applications included in this product 
may use the Microsoft® Windows® Preinstallation Environment software from Microsoft 
Corporation (“WinPE”). The WinPE softare included with this software may be used for boot, 
diagnostic, setup, restoration, installation, configuration, test or disaster recovery purposes only.  
NOTE: THIS SOFTWARE CONTAINS A SECURITY FEATURE THAT WILL CAUSE YOUR 
COMPUTER SYSTEM TO REBOOT WITHOUT PRIOR NOTIFICATION TO YOU AFTER 24 
HOURS OF CONTINUOUS USE. WinPE may not be used as a general purpose operating system 
or as a substitute for a fully functional version of any operating system product. Use of WinPE is 
“as-is.”
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Changes
The material in this document is for information purposes only and is subject to change without 
notice. While reasonable efforts have been made in the preparation of this document to assure its 
accuracy, Sonic Solutions assumes no liability resulting from errors or omissions in this 
document, nor from the use of the information contained herein.

Sonic Solutions reserves the right to make changes in the product design without reservation and 
without notification to its users.

Disclaimer
This product may allow you to reproduce materials in which you own the copyright or have 
obtained permission to copy from the copyright owner. Unless you own the copyright or have 
permission to copy such materials from the copyright owner, you may be violating copyright law 
and be subject to the payment of damages and other remedies. If you are uncertain of your rights, 
you should contact your legal advisor.

This product may be protected by one or more of the patents listed at http://www.sonic.com/
innovation/patents.
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Welcome to Roxio Creator
Welcome to Roxio Creator, the all-in-one digital media solution. 

Designed for beginners and experts alike, Creator makes it all easy—from 
simple and practical tasks, such as creating a backup copy of a disc, to fun 
and creative projects such as creating a home movie complete with 
introductions, transitions, music, and effects. 

Get creative and have fun with this powerful, intuitive, and easy-to-use 
suite of digital media components. Do more with your digital music, 
favorite photos, mobile phone, cherished video, and your important data 
files. Find all the tools you need in one place, with one easy-to-use interface. 

About this guide
This guide provides an overview of Creator to help you get started. For 
detailed information about how to use all of the features of Creator, see the 
online Help described in Where to find more information on page 21.

Some of the components available in Creator may not be described in this 
guide. Each component includes detailed online Help, which you can find 
under the component Help menu or by pressing F1.

Depending on the version of Creator you are using, some of the 
components described in this guide may not be available.
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Installing Creator
Follow this procedure to install Creator. 

To install Creator using the installation disc: 

1 Insert the Creator installation DVD into your DVD drive.

If Autorun is enabled on your computer, the Creator installation 
window appears automatically and you can skip step 2 and step 3.

2 Choose Start > Run.

3 Type d:\setup (substitute the appropriate letter of your DVD drive 
for d).

4 Follow the installation instructions that appear on the screen.

To install Creator using downloaded files:

1 Navigate to the Creator install package.

2 Double-click the setup.exe file.

3 Follow the on-screen instructions.
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Getting to know Creator
Start your digital media projects from Creator’s main window. Double-click 
the Creator desktop icon to begin.

Creator’s main window, featuring the project 
categories and frequent tasks.

Starting a task
Click one of the project category tabs on the left side of the window, and a 
task list appears on the right. Choose a task by clicking on its name. Some of 
the tasks are built into the main Creator window; others open in a separate 
window.
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Creator: What you can do
There are so many great things you can do with Creator. Here’s a partial list 
and how to get started:

Working with audio
You will find links to these tasks by selecting the Music-Audio project tab:

■ Make an audio CD that you can play anywhere. Select the Burn Audio 
CDs task.

■ Create an MP3 disc that holds hundreds of songs in MP3, WMA, or 
WAV format. Select the Burn MP3 CDs task.

■ Rip audio files from a CD to your computer. Select the Rip task.

■ Quickly capture (record) audio from Internet radio and other 
sources using your computer’s sound card. Select the 
Capture Audio from Sound Card task.

■ Record and edit sound clips and audio files, and to create your 
own audio mixes. Select the Edit Audio task.

■ Create music compilations to play on your home or car stereo, 
portable music player, DVD player, or on your computer. Use the new 
Beat Matching feature to create mixes your friends will envy. Select the 
Create Music Disc Projects task.

■ Transfer audiobooks from audio CDs or the Internet to an iPod, 
iPhone, or other portable device with just a few clicks. Select the 
Create Audiobooks task.

■ Create a DVD Music Disc with up to 50 hours of music using tracks 
from your computer or an audio disc. Choose from professionally 
designed styles or use your own background image, then burn your 
project to a disc and play on your computer or set-top player. Select the 
Create DVD Music Discs task.

■ Create digital audio files from your old LPs and tapes in just a few 
simple steps. You can then clean and enhance your audio files, burn 
them to an audio CD, or use them in your Creator projects. Select the 
Digitize LPs and Tapes task.
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Working with photos
You will find links to these tasks by selecting the Photo project tab:

■ Enhance, edit, and share your digital photos. Automatically adjust 
the exposure, saturation, and sharpness of photos. Fix common 
problems such as red eye. Select the Edit Photos task.

■ Create personalized calendars, greeting cards, and collages 
using your own photos. You can also create photo slideshows to share 
with others. Select the Create Projects task.

■ Enhance several photos at once using AutoFix and other photo 
tools. Rename or convert groups of photos to a different format. Select 
the Enhance Multiple Photos task.

■ Create a dramatic panorama by combining several photos into one. 
Select the Create Panoramas task.

■ E-mail your photos and photo projects to friends and family. Select 
the Email task.

■ Create a high-resolution photo slideshow in just a few clicks, 
including background audio and Pan and Zoom effects. Select the 
Create Slideshow task.

Working with video
You will find links to these tasks by selecting the Video-Movies project tab:

■ Make backup copies of personal DVD discs so you can store the 
originals for safekeeping. Convert video files to formats that can be 
played on a wide range of portable devices. Select the 
Copy or Convert Video task.

■ Play movie discs using the ultimate digital theater. Creator delivers 
the absolute highest quality video playback available for your PC and 
packs all of its powerful features into an extremely easy-to-use and 
intuitive user-interface. If your movie player doesn’t include Blu-ray 
support, don’t worry—it’s available as an inexpensive upgrade. Select 
the Play Movies task.

■ Create professional-looking video productions that combine your 
home videos and photos with audio, transitions, and special effects. 
Select the Edit Video—Advanced task.
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■ Make great looking video productions in a few easy steps. Select 
the Create DVDs task.

■ Create multimedia stories on DVD to share with family and friends. 
Capture and mix photos and video, include narration or a favorite 
sound track, create your own professional-looking menus, add 
transitions and animated backgrounds, and burn to DVD, Video CD, 
or Super VCD. Some versions even let you author Blu-ray movie discs. 
Select the Create DVDs—Advanced task.

Copy and data projects
You will find links to these tasks by selecting the Data-Copy project tab:

■ Copy files to a CD, DVD, or Blu-ray Disc. Select the Burn Data Disc 
task.

■ Duplicate an entire disc. Select the Copy Disc task.

■ Create data CDs and DVDs, and to archive large projects to multiple 
discs. Create advanced format and bootable discs, and more. In 
addition, you can choose to encrypt the files on the disc so that the 
files can only be accessed by someone entering a password that you 
select. Select the Burn Data Disc—Advanced task.

■ Backup the files on your computer to a wide range of storage 
devices including discs, external hard drives, and flash drives. 
Select the Backup Files task.

Note  The Backup Files task is not available in all version of 
Roxio Creator.
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Importing and organizing media files
You will find links to these tasks on more than one project tab:

■ Import photos and video files to your computer from your digital 
camera, mobile phone, or camcorder. Select the 
Import Photos or Capture Video tasks.

■ View and manage your media files in folders, and to organize them 
into personalized albums. Find files quickly by browsing or searching, 
and burn your files to a disc. Select the Browse and Manage Media task.

■ Share your media files with friends and family over your home 
network. Select the Browse and Manage Media task.

■ Transfer files to your wireless devices, and upload video files to the 
Internet. Select the Browse and Manage Media task.

Creating labels and disc inserts
You will find links to this tasks on all of the project tabs:

■ Make personalized disc labels and jewel case covers. Choose from 
dozens of professional designs, or create your own. Select the 
Create Labels task.

Don’t forget the Tools menu
■ Erase or finalize a disc, get disc information, and keep track of 

what’s on your discs. All of these tasks can be started from the Tools 
menu. This is also where you’ll go to create virtual disc drives.
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Completing a typical task
Each task in Creator is a little different. Some are incredibly simple. Others 
take a little time to master. To help you get started, let’s walk though one of 
the most useful projects—creating a disc that contains files copied from 
your computer.

1 Open Creator by double-clicking the icon that was placed on your 
computer desktop during installation. In most cases, the main Creator 
application window opens with the Home category selected. It will 
look something like this:

The Home window includes links to frequently used tasks.

On the left side of the window, you will see the names of several 
project categories. Since we are going to be making a data disc, click 
the Data-Copy category.

The application window changes and displays a set of tasks that are 
related to protecting or copying the valuable files stored on your 
computer.
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2 When you are ready, click Burn Data Disc.

A longer description appears when you hold the cursor over a 
task link.

The application window changes again. It now displays everything you 
need to set up your project and burn a disc. 

Burn Data Disc project window

As you can see, the Burn Data Disc project is built into the main 
Creator application window. Some projects are built into the main 
window; others open in a separate window. Many components that 
open in separate windows have names you may know: MyDVD, 
VideoWave, CinePlayer. They are all part of your Creator suite.



Getting started with Roxio Creator
Completing a typical task 19
3 To begin a data disc project, insert a blank CD, DVD, or Blu-ray Disc 
into your computer’s disc drive. (The project also allows you to add 
files to an existing data disc, but to keep things simple for this project, 
use a blank disc.)

4 Use the Destination drop-down menu to select the drive holding your 
blank disc. If your computer only has one disc drive, it will be selected 
automatically.

Click the Destination menu and choose from the list of available 
drives.

5 Now you are going to add the files you want to copy to the project.

Click the Add button located at the top of the Burn Data Disc project 
window. Choose Files or Folder from the submenu.

Use the toolbar to open the Quick Scan panel, add files, name 
your disc, and delete files from a project.

A dialog window opens. Use it to select the files or folders you would 
like to add.

6 Near the Add button on the project window toolbar is the Disc Name 
text box. Enter a name for your disc, so it will be easy to recognize the 
next time you use it.

While you are using the project toolbar, notice that it includes some 
other useful features. The Quick Scan panel makes it easy to select files 
by category. To the right of the Disc Name text box is the Make 
Bootable button. Use it to create a bootable disk that can be used to 
start your computer if something should ever go wrong with the 
Windows operating system.
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Before burning your disc, look along the bottom of the project 
window. Here you will find several project status indicators. The 
information presented varies from project to project and is updated 
when you change discs or destination drives.

Project information is displayed along the bottom of the window.

In this case, the indicator shows the project size, the type of disc in the 
drive, and the available disc space.

7 Now you are ready to burn a disc. To begin, click the large green 
button on the bottom right corner of the project window. A progress 
indicator appears, and your files are copied onto the disc.

The progress indicator shows a burn nearing the halfway point.

You don’t have to wait for this project to finish before starting one of 
the other projects in your suite. But you can only have one project of 
each type running at a time.

When the project is finished, remove your disc and click Finish. If you 
would like to save this project so the same file set can be easily burned 
in the future, click on the File menu and select Save.
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Where to find more information
This guide provides an overview of Creator to help you get started. For 
detailed information about how to use all of the features of Creator, see the 
online Help described below.

Online Help
Most Creator components have an extensive, searchable Help Center. Each 
Help Center includes step-by-step procedures and answers to frequently 
asked questions. 

To access the Help Center, choose Help > Component Help Center. To 
view context-sensitive Help for the activity you are currently doing, 
press F1.

Tutorials
Creator includes tutorials to help you quickly become familiar with many of 
its key features. Each tutorial includes tips and step-by-step instructions to 
help you get started creating exciting digital media projects. 

Choose any of the following ways to view a tutorial:
■ From Creator Home, choose Help > Tutorial, and then select the 

tutorial you want to view.

■ Visit the Roxio support Web site, located at http://support.roxio.com, 
for helpful “how-to” tutorials and other product information. 

Roxio online support
If you can’t find the answers you are looking for in the online Help or this 
guide, you can get the most current information from our Web site.

You can access the Roxio Web site in any of these ways:
■ Launch your Web browser and go to http://support.roxio.com.
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Creator support options

Unlimited self-help options
Roxio provides a variety of self help tools, including our virtual agent, a 
searchable knowledge base of support articles with troubleshooting tips, 
and tutorials that can help you get the most out of your Roxio products. 

Be sure to visit the Roxio Support Web site before you contact us by phone 
or e-mail—you’ll find answers to most of your questions at 
http://support.roxio.com.

Alternate support options
Alternate support options such as e-mail or telephone support may be 
available on a limited or paid basis for your Roxio product. Please visit our 
Web site at http://support.roxio.com to find out what options are available 
for your product.

Before you contact Roxio
If you can’t find the help you’re looking for in the online Help or on Roxio’s 
support Web site, you may decide to contact us by e-mail or phone. Before 
you do, visit http://support.roxio.com to view helpful steps that you can 
take before you contact us.

Contacting Roxio
Log in to our Customer Web portal to submit a request for assistance or to 
find support contact information for your location. You can find the 
customer Web portal at http://selfserve.roxio.com. 
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